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MINIMUM SYSTEM REQUIREMENTS

PROCESSOR: Macintosh computer with a 88040 or Powerbac processor

REQUIRED: System 7.0 or Later,8 MB RAM, 20 megabytes of hard drive Space, double-speed C0-ROM drive.
GRAPHICS: G40¥480 resolution with 256 colors

MUSIC: Sound Manager 3.1 or Later { Included with the installer)

Movie Playback: QuickTime 2.1 or Later (Ingluded with the installer )

HOW TO INSTALL DARK SEED II
1) Inert the DarkSeed I1 CD into your CO-ROM drive.
2) Double-click on the DarkSeed I €D icon
3) Double-click on the DarkSeed 11 Install icon to open the EASY Install Screen.
&) Within the Easy install you will find two options in the pull down menu:
A. Easy Install - This Option will Install DarkSeed Il with the default setting.
8. Custom Install - Allows you to tailor the installation of DarkSeed |1 to your Specifications:

(For example, * Options to select higher levels of installation t which may improve the speed of cinematic
Sequences within the game.)
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) When you are finish with you chaices, Click an the install button to begin installation of DarkSeed Il

(The Installation process will create a DarkSeed |1 Folder and Copy selected files (o the hard drive. This process
takes about Zminutes.)

6) When the installer has completed the file transfer you will be prompted to restart your system.

1) When the installation is complete the message “Setup Completed” will appear, click OK t proceed. Your
system will restart to allow changes to take effect.

8) To play Dark Seed II, double-click the Dark Seed Il Icon on your deskiop.

TO START DARK SEED Il
1) The Installation process created a folder on your Deskiop called DarkSeed I
2) By double-clicking on this folder you will be able to access the DarkSeed |1 Game lcon.

3) Again, Double-click on the DarkSeed I Icon to start the game.




Has it only been a year? It really seems fike more than a century since | took  leave of absence from my adver
tising agency. All | wanted was some peace and quiel, a place (o sit and contemplate. .. and write. My life as a
successful ad man was going great, but | wanted more. | got more. When | rented my house-my dream house-in
Woodland Hills, | had no idea what nightmares would hatch like spider eggs in my mind. There was the living
room mireor. ... and the missing piece that came in the mail. And that was just the start.

0, | would rather wipe the whole thing from my memory, but | fear | will never be allowed to forget. No ane who
has seen the Dark World could ever drive those images from bis head. No one. | broke down completely after it
was over, and took up unwilling residence in a variety of “rest homes” and mental wards. In those Sterile halls
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and strapped-down beds, | remembered all too much. There was the Keeper of the Scrolls, who first told me about
the Ancients and their evil plots. (Why me? | asked myself again and again.) And the Ancients, [hemselves. Grue-
some. Harrific. Sickening. ..

| thought | had destroyed them when | blew up their spaceship, but the memaries. .. the horor.... would not et me
0. | thought | had won, but this past year I've often wondered if death would not have been easier. The dreams...

Finally,in & kind of paralyzed daze, | moved back home. Mom was there (o take me in, a broken, confused man
whose dreams had turned dark and ugly. She didn't really understand my lethargy, my distance. She thought me
dreamy; she had no idea what | dreamed. They said | was in good health, but what did they know about the indeli-
ble stain of the Dark World?

Being home helped, a little, and |'d even begun to think about the normal matters of life again. The simple things.
You know, like dating and having friends. That's where Rita came in. Rita Scanion, my high school sweethear.
We hadn't seen each other in  long time, but now that | was hack, we were getting reacquainted. Although Rita
had chanoed and was more distant, | didn’t worry ahout it - after all, | had also changed, and in stranger ways
than most. We went to our high school reunion together, or so they tell me. | don’t recall a thing about t. The night
vanished, just one big bfack hole in my memory. | think | got drunk.

I'm certain that | didn't murder Rita, though. How could | have?

It's the Dark World. | know it is. They've found me again, and now they've murdered Rita. Sheriff Butler thinks |
did it. He'd never believe the truth. Nobady will believe me.

And my headaches are getting worse. Or. Sims just keeps giving me medicine and more medicine. He doesn't
understand either. |'m tired of being medicated all the time, 'm tired of the headaches. But most of all, 'm
scared. The Ancients are back. ..




GAME CONTROLS

[ARK SEED 11 is most easily played with an Apple/Macintosh mouse and Keyhoard. The correspanding keyboard
controls are the ENTER key (mouse buttonjand the Space Bar to change the characteristic of the cursor. The
cursor arrow keys control directional movement.

On the screen, you will see an arrow-shaped cursor that you contral. To Interact with the game place cursor with
the desired cursor function over an ohject or pathway and click the mouse button(Action command). When your
CUrsor s over  connecting doorway which leads to another room or location, this single arow cursar changes
{0 four inward-pointing arrows,

To make Mike Dawson move, position the arrow cursor wherever you want him 1o go and click the mouse
hutton(Action command), Mike will walk to this new position. If there is an unavoidable obstruction in his path
fie will stap at the closest possible point. If you press the mouse button when the multiple arrows are displayed.
Mike will walk to the doorway and then to the adjoining location.

The Space bar is used to cycle the cursor shape througha ™7 (look) shape, a “hand” (use/take/talk) shape
and an “arrow” (o) shape.

When the “7” and “hand” cursors are placed over items which have mare information available, or which Mike
uan pick up or use, the cursor changes shape. The “7" shape changes toa 1", and the “open hand” shape
changes to 8 “pointing finger”.

To examine or manipulate an obiect, select the “7" or “hand” icon using the mause buttan, then place it over
the desired object, and click the mouse button to activate. If you use the “hand"” icon to pick up an object, it is
aded to your inventory. (For more info on inventory, see “Your Inventory” below.)

Keyboard Controls
Spacebar Toggles the cursor fuctions
fnter  Same as mouse hutton.

Note; The arrow keys or numeric keypad can be used ta control directional movement of the pointer.

0 Sound On/Off M Music On/0f
P Pause Game A About Box
Fl Help F2  Options

F6  New Game Fl  Load Game
F8  Save Game F9  Boss Key On/Off

FIT Walk Speed

Boss Key - The Boss Key can be activated by pressing the [FS)] key. This ontion will instantly suspend your game
and change your screen o something tha looks  bit more productive. Press the [FS] key again o retum to the
game.

Walk Speed -The Walk Speed key can be actvated by ressing the [F11] key. This option willallow you o con
trol how fast Mike Dawson walks. Each time you press the [F11] key, you wil togole between Slow, Medium,
and Fast mode.




GAME OPTIONS

You may access the game option menus by moving the pointer to the lop of the Screen. There are three menus:
File, Option!, and Help.

Choose the File menu to start a new game, 1o load an existing Saved game, to save the current game in
progress, or 1o exit back to the desklop.

Chioose the Option! menu to display a dialog box with several settings for how the game’s graphics and sound
are played. Options include sound effect and music volume, type of music playback you want, text display speed,
animation resolution, dialog options, and whether o skip or play transitional animations.

Choose the Help menu for instructions on how to play Dark Seed I

THE FILE MENU

[0 restart, save, load, or quit a game in progress, move the pointer o the top of the screen. A Macintosh menu
Bar will appear. Place the cursor over the File menu and click the mouse button to reveal the following options:

llew Game

To start @ new game from the beginning, click on New Game or press FG. An alert box will appear asking if you
really want to start a new game. Click the Y&S button to Start a new game from the beginning. Click on the Can-
Cel button if you change your mind and want to retum to your game in progress.

Load Game
1o load a previously saved game, select Load Game from the File menu or press F7 You'll see & Macintosh

window displaying a lst of saved games Clck on and highlight the saved game you wish to play, then click on Load
at the right of the window. f you change your mind, click on the Cancel button at the bottom of the window,

Save Game
o save a game in progress, select Save Game from the File menu or press FA. You'l see a Macintosh save

window, Type in some descriptive text to remind you where you were in the game i the Macintosh Saveas line.
Finally,click on the Save bution at the right of the window. If you change your mind, click on the Cancel button at
the bottom of the window. f you want to re-use one of the slots, simply select that one and type a new description
there. An alert box will appear and ask you if you want to overwrite the previous game. Clck Save or Cancel.

Exit

To quit the game at any time, select Exit from the File menu or press the ESE key on your keyboard. You will be
asked if you want to save your current game. Click on the Yes or No button, and the game will end. If you change
your mind, click on the Cancel button.




THE OPTION! MENU

To access the Option! menu, move the cursor to the top of the screen and then click on the word Option! to
apen the Play Setting dialog box. There are several options available in this dialog box:

Sound Effect Volume: Use the mouse to move the slider to the right to raise the volume; to the left to fower
(he volume of the game’s sound effects and dialogue.

Sound Effects Disable: Click here to disable all sound effects and dialogue.

Music Volume: Use the mouse to move the slider ta the right to raise the music volume; to the left to lower the
music volume.

Music Disable: Click here to disable all music.

Text Display Sugﬂﬂ: Click on the radio button that represents the text display speed you prefer. You may
choose Fast, Medium, Slow or Click. If you select Click, the text will not advance until you click the mouse
button.

Animations: Click on the appropriate resolution for animations. If you aren’t sure what your display card can
handle, use the default setting.

Dialog Option: Choose the radio button that represents the way you want dialog to be presented in the game.
You can have both audio and text, audio only, or text only.

Skip Transitional Animations: Click on the checkbox if you do not want to view the animations that some-
limes appear when you travel to a new location. Even if you skip Transitional Animations, you will still get all the
information necessary for solving the mystery.
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THE HELP MENU

To aceess the Help menu, move the pointer to the top of the screen and then click on the word Help. An onling
version of this manual will initiate, allowing you to more easily search for a tapic. You can also access the fielp
meny by pressing the [F1] key.
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CONVERSATIONS

When Mike is talking with another characier, a
Conversation Window will appear at the bot-
tom of the screen. The Conversation Window
contains the choices that Mike can make during a
conversation, To have Mike say something, move
the pointer over the text you want (the selected _
text will trn white) and click the mouse button. S
Mike will then speak the words aloud and the
other character will reply. When the other character has finished speaking, you may select another option unless
the conversation has ended. Clicking on the mouse bution when another character is talking will cause the cur-
fent speect to end, presenting your next option. Be careful not to click too quickly; you might miss a character's
response. When the conversation is over, the Conversation Window will disappear.

To the left of the Conversation Window is a skull icon. When more than three conversation choices are avail-
able, arrows will appear allowing you to scroll up or down through additional conversation choices. Be sure o
check for these arrows after another character has spoken. The Conversation Window only shows three lines
0f text at a time. If the arrows appear, you have more conversation choices that you should consider. lse the
arrows (o scroll all the way to the end before selecting an option. What you chaose for Mike to say can radically
alfect the game, so choose with care.

12

YOUR INVENTORY

To view your current inventory, move the cursor to the bottom of the screen. The inventory window will appear
at the bottom of the game window. At the beginning of the game, there is nothing in your inventory, but when you
collect items, they will appear as icons in the inventory window. To examine an item in your inventory, place the
“" vursor over the inventory item and click the mouse button. To use Something in your inventory, use the
“hand” cursor. When you click on the item, the cursor will change to the shape of the item selected. Now you
may move (e cursor and click where you want to use the inventory item. You may move the cursor anywhere on
tiie game screen, or even over other inventory items. You'll notice that the cursor will appear as the “hand”
shape unless it is over something that can be manipulated or affected by the item you chose. To de-select an
inventory item after you've selected it, press the mouse button; the item will remain in your inventory.

If you have more items in your inventory than will fitin the inventary window, arrow icons will appear at the left
and right edges of the inventory window. Click on these arrows to scroll through items that are currently not dis-
Dlayed.
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HELPFUL HINTS

At the start of Mike's adventure, you will only catch olimpses of the Dark World through Mike's dreams. As you
delve deeper into the mystery of Rita’s murder, Mike will have an opportunity o travel ta the Dark World again.

To clear his name, Mike will have to play the role of detective. As he gathers more and more information, be sure
to visit suspects and other sources of information again. A new piece of evidence may inspire Mike to notice
details he had overlooked on first inspaction.

If you can't decide what lead Lo follow next, it on the bench at Mike’s front porch to see if his friend Jack is
cruising the neighborhood. Jack is a good Source of information about the town's dirty little secrets.

Whenever Mike oets a headache, go to Dr. Sims office for therapy sessions. Mike's hypnosis-induced dreams
can provide him insight inta what happened during the night of the high schoal reunion.

Remember that the Dark World is & parallel to our Normal World. Actions in one universe can impact the other
universe, particularly where the convergence is strongest

Thoroughly explore any mazes you encounter. One maze has a secret that you must exploit fo thwart the
Ancients” plans.

Save your game frequently, especially if you are about to try something dangerous or talk to an armed Dark
Worlder. Mike can di in the Dark World if he makes too many mistakes.

Pay altention to the changes in the pointer shapes as you move them over obiects and backgrounds. They pro-
vide important clues about your environment,

BEGINNING WALKTHROUGH

This short walkthrough s intended to help you familiarize yourself with the way Dark Seed Il works. It isn't
meant to take you very far into the game, but simply to show you how to use the Conversation Window and how
{o explore the world.

Mike's Bedroom

At the beginning of the game, Sheriff Buller
shows up at Mike's door and questions him about
Rita’s murder. In this conversation, it dogsn't mat-
ter too much which options you choose, but some
options will reveal a lot more information. Some
of that information might turn out to be useful
later in the game, although obvious Statements,
like those about being late for the doctor, or hav-
ing a headache, will bring the conversation 1o  close.

When Mike's conversation with the Sheriff is over, the Sheriff will [eave. Now you can explore Mike's bedroom.
This is & chance to familiarize yourself with the game controls

1. Use the Space bar a few times and notice how the pointer changes shape. The arrow-shaped icon s the
o pointer, Use the G0 pointer to move Mike from one place to another. The exclamation point icon is the
Look pointer. Use this pointer when you want (o lear about something you see on the sereen. The hand icon
is the Use pointer. Use this pointer when you want to pick up or manipulate something on the screen or in
Mike's inventary.



Note that when you are using the Look pointer, it may appear as a question mark icon. Move it around on the
screen until it tums into an exclamation point, then click to get information about the object underneath the
nointer. Mso, although you will use the Go (arrow) pointer to make Mike move around, Mike will also move if you
click on an object with either the Use (hand) or the Look (exclamation point) pointer.

Keyboard Note: If you prefer to play from a keyboard, you can toggle between each of the three pointers by
ressing the Spacebar. You can then use the selected pointer by pressing the (Enter] key.

7. thange the pointer to either the Use or Look icons and move the mouse around. Notice that the pointers
change shape to indicate whether you can interact with a part of the room. For instance, moving either pointer
fram the blank wall to the poster of the swashbuckling swordsman above the bed causes the icon o change a
“ 102 ”1” When the look icon changes to an exclamation point click the mouse bution fo get information
about the poster. You'll hear & voice-over comment from Mike. Listen carefully to what he says; there may be a
clug init

3. Next use the Look pointer to examine the trophy, by clicking the mouse buttan when the icon s directly over
the traphy, Listen to what Mike says.

4. Click on the closet door with the Look pointer, and, again, listen to Mike.

5. Now you can explore other items in the room if you wish, but when you're ready, switch to the GO pointer
(Arraw)by using the Spacebar. Next, move the G0 pointer over the exit door on the far right of the screen.
The Go pointer will change to the shape of four amows pointing inward. Click the mouse button. This will cause
Mike to leave the room and enter the Kitchen.

THE KITCHEN

Now you're in the Kitchen. Mike's mother, Mrs. Dawson, is busy al the Stove, as usual. Perhaps she hias some-
16

thing interesting o say. ...

. With the Use painter, click on Mom. During this first conversation with Mom, you can discover a few more
background facts, but nothing critical.If Mike mentions that he's getting  headache, Mrs. Dawson will remind
him of his medicine. “That’s what it's for,” she says.

7. Once you've completed the first conversation with Mom, and she returns Lo her cooking, click on her again to
get a clue about watching television.

8. With the Look pointer, examine the raom. You'll otice some objects on the refrigerator.
0. Switch to the Uise pointer and click on the hapny-face magnet. Mike will (ke the magnet and puttn his pocket.

10. Now move the pointer to the bottom of the screen. The Inventory Window will appear, and you'll see that the
magnet has been added Lo Mike's inventory.

If you tlick on the magnet (or any object in
inventory) with the Look pointer, Mike will make
some comment or abservation ahout the object. If
you click on the magnet (or any object in inven-
tory) with the Use pointer, the pointer will
change 1o a shape that resembles the object
you've selected. Try it

11. With the Use pointer active, click on the e
magnel and then move the pointer around in the
100,
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Notice that the pointer looks like & hand until you place it over the refrierator. Then it changes to look like the
magnet. This tells you that the magnet can be used with the refrigerator. If you click on the refrigerator now, Mike
Will return the magnet, To put the magnet back in Mike's inventory, drag the pointer to the botiom of the Screen
again, opening the Inventory Window, and click on the magnet again.

12. Assuming you still have the magne{, there's not much more to do here. Perhaps you will find something to do
in the Living Room. With the Move pointer, click on the door to the right.

Now you're on your own. Good luck. O, and if you really need more help...

IFYOU NEED ADDITIONAL GAME PLAY HINTS, YOU CAN REACH OUR
HINT LINE AT 1-900-407-HINT (4468)

You must have a touch-tone phone to use this service. The hint line is available 24 kours a day. The charae is §.95
ner minute. You must be 18 or have parental permission to use this service. This service is only available within
the 1.5

OR YOU CAN PURCHASE THE OFFICIAL STRATEGY GUIDE BY CALLING THE CYBERDREAMS
ORDER LINE AT 816-225-1049

The Oark Seed I1 Official Strateqy Guide is only $19.95 -+ $6.50 for shipping in the USA, California residents adi
§.25% sales tax. Canadian orders add $9.50 (US currency only) for shipping. Visa o Mastercard accepted.

TROUBLESHOOTING

Memory Problems
Virtual Memory: We have found that turning off virtual memory improves video play back and frees up extra
memory. This i located in the Memary option in the Control Panel under the Apple pull down menu.

Extensions: If you are experiencing low memory messages? Please wrm off unnecessary extensions in you
system folder under the Extensions Manager or Extensions. (Extensions necessary for to play; QuickTime; Sound
Manager: and Apple CD-ROM)

Note: Remember you will need to restart you computer for the chanes Lo take effect.

Video Problems
Verify that your screen resolution is G40x480 for best results and that you are using the most current extensions
for your video and monitor.

Audio Problems
Ensure QuickTime 2.1 is properly installed and verify that all required sound extensions are activated.

Mouse Problem
Iake sure you are using a 100% Macintosh compatible mouse.

No Multi-tasking
Because of the large amount of system resources that Dark Seed Il requires, you should not attempl (o use any
multi-tasking functions or run other proorams while playing Dark Seed |1,

Screen Savers
While using Dark Seed |1 you should disable any screen savers that are enabled



TECHNICAL ASSISTANCE

1 you are experiencing technical difficultes with Dark Seed Il and you are a registered user, you may call
our technical support department for assistance at (818) 222-3348. Cyberdreams technical support is avail-
afle during normal business hours (Mon-Fri, Sam to 5om PST). To better serve you, please have information
regarding the manufacturer, model, operating system, available memory and system configuration of your com-
puter when you contact us.

I you have a modem, you can also contact us through our Bulletin Board Service by dialing (B18) 223-8139.

ON-LINE SUPPORT VIA COMPUSERVE

For on-fine suppartof Dark Seed 11 via CompuServe, call (B00) 524-3368 (in North America) and ask for rep-
cesentative #503 1o get your FREE introductory membership and $15.00 usage credit. If you are lready 8
member of CompuServe, tyoe the command G0 GAMAPUB at any ! prompt to get the Cyberdreams Support area
(Section/Library 5),or contact our technical support department at |0 72662,120.

ABOUT H. R. GIGER

.8, Giger was born in Chur, Switzerland in 1940, As a child, he developed & powerful fascination with all things
surreal and macabre. His need to express himself and share the unique aspects of his vivid imagination drew
him 1o the visual arts. Giger's own dreams and the brilliant imagery of such fantastique geniuses as Gustav
Meyrink, Jean Cocteau, Alfred Kubin and H.P. Lovecraft, combined to form @ rich soil from which the amazing
imagery of Giger's art has come 1o sprout. It has grown into the vast canon of exatic women, wondrously dis
Lurbing landscapes and frightening creatures that has captured the fascination of millions of fans worldwide.

Meticulously detailed, Giger's paintings are done on large canvases and worked and reworked by this maestra
of the airbrush. It was Giger's popular art book, Neronomicon, that caught the eye of director Ridley Scott as he
was searching for the right look for a creature in his upcoming film. That creature, of course, turned out fo be the
Alien, and Giger's masterful designs for the film of that same name garnered him a much deserved Academy
Award,

Giger's fascinating biomechanical style, that brilliant synthesis of flesh and machine, has been realized not only
through his paintings, but also through sculpture pieces, elegant furniture, and architectural and interior design
rojects. His paintings have heen displayed in galleries and museums throughout the world. H.R. Giger has
gamed his place in the international art Scene.




“Giger is the master of fantastic ar”
OMAL MAGAZINE

“Giger's Oscarwinning work on ALIEN changed the look of science fiction”
CINEFANTASTIOUE

“Biger knows what we fear”
HARLAN ELLISON

“his silence is as profound as his genius”
CLIVE BARKER

“(ne of Europe’s leading fabulist artists”
PENTHOUSE

“Brilliantly perverse”
NEWSWEEK

“The evolutionary genius. .. Giger”
TIMOTHY LEARY

“H.A. Giger creates eerie erolic fantasies with a nightmare imagination and an airbrush”

PEOPLE MAGALINE
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THE MAKING OF DARK SEED Il

“It's beautiful!” was H. B, Giger's enthusiastic reaction upon seeing the original Dark Seed for the first time. AS
3 world-renowned fine artist, Giger was skeptical when Cyberdreams initially approached him about creating a
computer game based upn his macabre “biomechanical” landscapes. He agreed to grant Cyberdreams access
to His body of work only after lengthy negotiations. But when Giger saw the oreat care that Cyberdreams had
taken 0 preserve the elements of his art, he was pleased with how effectively his images ransfated (o an inter-
active environment. Game players were equally pleased with Dark Seed. The game became a sleeper hil,
winning the Software Publishers Association's 1993 Excellence in Software Award for Best Fantasy Role-Play-
ing/Adventure Game.

lark Seed players wanted to see more of hero Mike Dawson's nightmarish journey into Giger's Dark World, and
s Cyberdreams brought in game producer David Mullich to create the sequel. Not only had Mylich developed
other adventure games with dark psychological themes such as The Prisoner and | Have o Mouth, And [ Must
Suream, he also admitted to being a Giger fan since high school, when he bought an Emerson, Lake and Palmer
album with & cover designed by the Swiss surrealist. With the goal of surpassing the high standards set by the
ariginal Dark Seed, he assembled a development team of the most talented and demented minds working in
Interactive entertainment.

Sine Giger's disturbing images have had such a profound impact on science fiction literature and cinema —
e designed creatures appearing in the films Alien, Poliergeist Il and Species — it seemed fitting that the
sequel should have a literary quality. Designer Raymond Benson, whose saftware credits include Stephen King's
The Mist. Ultima V11 -The Black Gate, Return of the Phantom and Are You Afraid Of The Dark?, was commissioned
\o wirite 3 Story that continued Mike Dawson's horrifying adventures. Instructed that the sequel also must take
Mike Dawson from our Normal World into Giger's Dark World, Benson crafted a psychological murder mystery

thal begins in  quirky, “David Lynchian” small town and draws us into a terifying alternate niverse that is a
23




metaphor for madness. Those who reach the game's chilling conclusion will appreciate how well Benson's tale
allegorizes what Giger says about his art: “I expel these creatures, and their pain, by painting them onto a sur-
face, trapping them forever. In a somewhat symbolic manner, | also free myself”

(siger later requested that the sequel include images that had recently been haunting kim, including a sled car-
fying a vat down the banister of an endless staircase (inspired by Giger's “Shaft” pieces). Since Benson had
moved on to other projects, Cyberdreams consulted science fiction author John Shirley (The Eclipse Trilogy, and
the screenplay for “The Crow”) on how to fit Giger's visuals into the sequel, and he also contributed many addi-
lional ideas for fleshing out the Dark World. To put the finishing touches on the game dialogue, Cyberdreams
brought in Keith Herber, a horrar author who edited the Call of Cthulhu role-playing game and is an expert on H.
P Lovecraft

Dnce the game design was completed, Cyberdreams hired Destiny Software Productions of Vancouver, Canada to
implement it. For the original Dark Seed, Giger had insisted that Cyberdreams use a high reslution VGA graph-
ics mode (640 by 350 pixels, 16 colors) to avoid the “square and jagged” look found in most computer games of
the time. So that the sequel would also be visually cutting edoe, Destiny's programming team enhanced their
araphics routines o support an even mare advanced graphics made, SVGA (640 x 480 pixels, 258 colors), while
running under a Windows or Windows 35 environment.

To create the character animations of Mike Dawson and the other Normal World denizens, Destiny photographed
the movements of live models with  high speed camera, scanned the photographs into digital form, and played
images back as animations. |n addition to professianal performers, some of Destiny’s staff members volunteered
(0 be character models. By a happy coincidence, artist Chris Gilbert was a dead-ringer for the Mike Dawson
character from the original Dark Seed.

The art 1eam at Destiny also proved to be skilled at combining a variety of imagery from Giger's fantastic art-
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work and using both 2-0 and 3-0 techniques to create new Dark World hackgrounds. Several manths into the
projec's development, Mullich, Cyberdreams' art director Peter Delgads, and Destiny artist 6regg Haggman vis-
ed iger's home in Zurich to show off their progress. Giger was very impressed with the graphic improvements
over the original Dark Seed, and offered many helpful suggestions about scaling, placement and composition.
One of his most significant contributians was the placement of metal catwalks throughout the Dark World, so
that Mike Dawson would always feel in peril,being continuously suspended over a botiomless pit.

S0 that the Normal World wauld have an equally distinct look, Cyberdreams enlisted the talents of artist Jeff
Hilhers to create the Normal World backgrounds. Hilbers, who has reviously served as art director on producer
Wulfich's projects when both were at The Walt Disney Company, brought his unique sense of the macabre to Mike
Uawson'’s home town. The quaint images of what superficially appears o be a pleasant community proves pn

closer inspection (o be infected with perversity, symbolizing the Dark World's growing influence on Crowley,
[pyas.

Rudio was the final element needed to immerse you into Giger's ghastly universe. Cyberdreams commissioned
Ielevision and film composer Mark Morgan (Stephen King's The Stand television mini-series) to write more than
/0 pieces of original MIDI music for the adventure, which music producer David B. Schultz of DBS Music then
specially arranged for optimum performance on the Sound Blaster AWES? card. Destiny Software Productions
Ihen added haunting sound effects and ambiance through the game.

With more than forty speaking parts in the adventure, Cyberdreams contracted Lisa Wasserman of Virtual Cast-
i to cast and direct some of the finest voice-over actors performing in interactive entertainment. The dialogue
sessions were recorded at Lucas Art's old Skywalker Sound facilites in Los Angeles by Cheshire Multimedia
Sound. Sound engineers Todd Bozung and Greg Chapman digitally enhanced many of the voices to help drama-
llz2 Giger's warld of biomechanoids, goddesses and diabolical creatures.
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\pholding Cyberdreams’ reputation far innovative packaging, Director of Sales and Marketing Andrew Balzer
commissioned Brioht & Associates to create a box design that was as provocative as the adveniure contained
within. The box showcases a portion of Giger's 1978 iece “Iluminatus 1" in which a woman's cheek is pierced
by her safety-pin sunglasses. The adventure will be made available through the efforts of Cyberdreams Sales &
Marketing team of Andrew Balzer and Daniel Peli together with MGH Interactive (responsible for North Ameri-
can distribution) and Cyberdreams” foreign distributors.

The production, development and marketing team for Dark Seed (I iave unleashed a new horror into Mjke ﬂa_w-
son's unending nightmare. As you take this dark jouney into the depths of madness, we hope that, as Biger Iries
to do with his own artwork, you free yourself of some of your own demons.
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ABOUT CYBERDREAMS

(yherdreams was formed to create high quality interactive entertainment software for home computers and ded-
icated game systems. Each product is designed, scripted and story hoarded by game play experts and world
amous artists, designers, writers and filmmakers such as H.A. Giger (Alien, Species), Syd Mead (Blade Runner,
Iron, 2010), Harlan Elison (the most honored author in the world of imaginative literature) and Wes Craven (cre-
ator of A Nightmare on Eim Street). Cyberdreams” audience is adult science-fiction enthusiasts who appreciate
sophisticated storylines, state-of-the-art animation and cutting-edge interactive technology.
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LIMITED WARRANTY

(VHTTE WARRANTY. CYBERDAEAMS, INC. warcamts 1 the riginal consumer gurchaser hat the disketies or (0 AOM furnished in this praduct (here
saler. Software) will be free from defects in materials and workmanshi under normal use far  period of nimety (90) davs from the date of purchase
s euidenced by the receipt of purchase).

CONSUMER REWEDIES CYBERUREAMS, INC's. entire liahilit and the ariginal consumer pUrchaser’s BXcliste (emedy shall be, at CYDEROAEAMS, INC's

i, et or enlacement of the Saftware that does not meet CYBERDAEAMS, INC.s Limited Warranty and whith is returned to CYBERDREAMS, INC
wi & eopy of the receipt of purchase. This Limited Warcanty is void f failure of the Software has tesulied from acciden, abuse, or misapplication
iy replacement Saftware wil be warranted for the cemainder of the arigiial warranty period o 30 tays, whicheser S longer

IOUCT IS SOLD AS 1S THE SOFTWARE, DISKETTES O C0-ROM, NCUMENTATION AND OTHER ITERES ARE PROVIDED AS IS, THERE IS NO WARRANTY
(1 MEACHARTABILITY. N0 WARRANTY OF FITHESS FOR A PARTICULAR USE, AN NO OTHER WARRANTY OF AKY KIKD. FITHER EXPRESSED O IMPLIED
AIEBARDING THE SOFTWARE, (ISKETTES 0A CO-AOM OR DDCUMENTATION, EXCEFT AS EXPRESSLY PROVIDED (N THE PAECEDING FARAGRAPHS. THE
(NTIRE RISK 1O THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE, DISKETTES OR CO-OM, AND DOCUMENTATION (S ASSUMED BY THE CON
SHIMGER,

NSEDUENTIAL DAMAGES. I O EVENT SHALL CYBERDREAMS, INC. DR 175 SUPPLIERS BF LIABLE TO THE CONSUMER OR ANY THIRD PARTY FOR ANY
CUNSEQUENTIAL SPECIAL O INDIRECT DAMAGES RESULTING FRDM POSSESSION, USE, OH MALFUNCTION OF THIS PODUCT. IKELUDING WITHOUT LIN-
[14110H, DAMAGE T0 PROPERTY, ANO TO THE EXTENT PERMITTED BY LAV, OAMAGES FOR PERSONAL NJURY, EVEN IF CYRERDAEAMS, INC. HAS BEEN
AVISED OF THE POSSIBILITY DF ANY SUCH DAMAGES OR LOSS. SOME STATES 0D NOT ALLOW LIMITATIONS ON THE DURATION DF WPLIED WAR-
AANTIES AND/OR THE ECLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND THUS THE PRECEDING LINITATION AND/OR
(AELUSIONS AND LIMITATIONS MAY NOT APPEY

FSAL RIGHTS, THIS WARRANTY GIVES YOU SPELIIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS DEPENDING ON IHE LAWS INYOUR STATE. YOU
AGAEE THE LIABILITY OF CYBEADREAMS, INC ARISING DT OF AWY KIND OF LEGAL CLAIM (WHETHER N CONTRACT, TORT, OR OTHERWISE) WILL K0T
(4EEED THE AMOUNT Y0U DRIGINALLY PAID FOR THE USE OF THIS PRODUCT

OPYMIGHT The enclosed software product and this manual are copyrighted and all rights are reserved by [YBERDAREARS, INC. Mo part o this man-
il o any of the accampanying materials may e copied, repraduced, Irinslated In any form or medium without the prinr written consent ol
YHERDREAMS, INC

NTICE CYBERREAMS. INC.reserves the right to make improvements in the product descaibe i his manual at any time and without notice.

[YOEAREAMS, INC. 29580 Calabasas Moad Suite 107 Calabasas, CA 91302
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